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BR&E ProMax® 3.x (Build 3.2.10286.0) Release Notes 
13 October 2010 

Bryan Research & Engineering, Inc. 
 

Welcome to ProMax 3.2 (build 3.2.10286.0).  This upgrade is a maintenance upgrade to earlier 
ProMax 3.x releases and contains several new features and stability improvements.  If you need 
assistance or would like to report a problem in ProMax, please contact our technical support 
group at support@bre.com.  You may also consult our frequently asked questions list at 
http://www.bre.com/support/promax-faq.aspx.  In addition to common usage questions, this list 
contains solutions to common problems related to program installation.  Finally, we would 
encourage you to seek our assistance in questions related to program applicability.  ProMax is a 
robust, accurate simulator that can be used in many processes. 
 
These release notes describe the major changes that have occurred between the ProMax 3.x 
release and the ProMax 2.0 release.  Refer to the release notes from previous versions of ProMax 
to determine the significant changes made within a specific release and the changes made 
relative to the predecessors of ProMax, PROSIM® and TSWEET®.  These can also be requested 
by email from our support group at support@bre.com. 
  
ProMax utilizes Microsoft Visio® 2002, Microsoft Visio 2003, Microsoft Visio 2007, or 
Microsoft Visio 2010 as its drawing package.  All flowsheets are drawn using Visio.  You must 
have a legal copy of either Microsoft Visio 2002, 2003, 2007, or 2010 (x86) Premium, 
Professional, or Standard to use ProMax through its GUI.  This particular version of ProMax 
is not compatible with other releases of Visio, including any future releases.  The version of 
Visio installed on your computer can be found by using the Help->About menu item in Visio.  
Microsoft offers a 60 day trial version of Visio on its website at http://office.microsoft.com/visio.  
Additionally, depending on the version, Visio requires a patch from Microsoft to use 
successfully with ProMax.  See Obtaining the Required Visio Patch section below for more 
details. 
 
The following table lists the operating system compatibility with ProMax 3.x.  Special attention 
should be paid to the notes concerning your respective operating system.  Upgrading the 
operating system is strongly recommended for any system that is not in the mainstream support 
phase of Microsoft as BR&E does not perform routine testing of ProMax on these platforms and 
full compatibility is suspect.  For all systems, a minimum of 512 MB of RAM is required, with 
more usually required depending on operating system, application load, and other software 
needs. 
 
Operating System Edition Notes 
Windows 2000 Professional or 

Server 
Requires SP4 and IE6 SP1.  Also requires 
MDAC 2.8 SP1 manual installation prior to 
ProMax installation.  MDAC and the MDAC 
Component Checker utility (used to determine 
current installed version) are available from 
http://www.microsoft.com/downloads.  
Immediate upgrade recommended as BR&E will 
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not support this platform in the next major 
release due to support termination by Microsoft.  
Microsoft ended the extended support phase for 
Windows 2000 on 13 July 2010. 

Windows XP All x86 Requires SP2 with SP3 recommended.  
Recommend upgrading SP2 systems with 
hotfixes http://support.microsoft.com/kb/921337 
and http://support.microsoft.com/kb/943232 
prior to installing ProMax to avoid potential 
problems during install.  Users of SP3 systems 
that fail during MSXML configuration in the 
SQL install should see 
http://www.bre.com/support/promax-faq.aspx for 
a solution.  Microsoft support for SP2 ended 13 
July 2010. 

Windows XP Professional x64 SP2 required 
Windows Server 2003 x86 or x64 SP2/R2 required 
Windows Vista All x86 and x64 RTM/SP1/SP2 

Microsoft support for RTM ended 10 April 2010.
Windows Server 2008 All x86 and x64 SP1/SP2/R2 
Windows Server 2008 R2 x86 unavailable RTM 
Windows 7 All x86 and x64 RTM 
 
When ProMax is loaded by Visio, Visio will issue a warning concerning the presence of macros.  
This warning is provided by Microsoft Office applications to warn you of the possible presence 
of viruses that may be present within the macros.  Microsoft has created a strategy where the 
macros are digitally signed by their author so you are assured of their integrity.  Digital 
signatures require a trusted third party to verify the authenticity of the signature and its data.  Not 
all macros are signed.  The author of unsigned macros is unknown and usually should be 
considered suspect.  All BR&E documents pertaining to Visio or other Microsoft Office 
applications are digitally signed.  This digital signature can be verified by inspecting the 
certificate displayed in the warning message.  You must allow or trust all BR&E signed macros 
to execute or you will prevent ProMax from functioning properly.  You should add BR&E to 
your trusted list of macros to ensure proper execution of ProMax.  
 
Obtaining the Required Visio Patch or Service Pack in Visio 2002 & 2003 
 
During ProMax development in mid 2003, BR&E discovered a problem in Microsoft Visio that 
can cause corruption in files saved in ProMax or Visio due to loss of digital certificate 
signatures.  While this problem was discovered during the initial beta test period for Visio 2003, 
we were unable to determine the exact cause of the problem with Microsoft at that time and 
consequently a solution was not obtainable.  Early in 2004, we discovered the fundamental cause 
of the problem and were able to work with Microsoft to develop a Visio patch to solve this issue. 
 
The digital certificate problem is present in both Visio 2002 and Visio 2003.  Unfortunately, it 
may be more severe in Visio 2002 because the problem is present without warning to the user.  
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With the release of Microsoft Office 2003 products, Microsoft set the default macro security 
level in documents to high.  This causes any document with a missing digital certificate to fail on 
load.  However, in Visio 2002, the default macro security level is medium which does not cause 
failure on load.  Files saved with Visio 2002 will likely fail if the user upgrades to Visio 2003 if 
the digital signature has been silently lost unless the security level is changed. 
 
You can determine if the minimum patch level is met by inspecting the full build available from 
the Help->About menu item in Visio.  For Visio 2003, the build number must be 11.4301.6360 
or greater.  For Visio 2002, the build number must be 10.0.6002 or greater. 
 
For Visio 2003 users, the patch has been rolled into Service Pack 2 (and Service Pack 3) for 
Visio 2003 which may be downloaded from the Microsoft Office website at 
http://office.microsoft.com/en-us/officeupdate/default.aspx.  This update is normally applied 
through the automatic updating process in Microsoft Windows and does not require manual 
installation.  However, for Visio 2002 users, the method to obtain the fix is through a Visio patch 
or hotfix.  As of this writing the patch has not been rolled into a Visio 2002 Service Pack.  Due 
to copyright restrictions, the patch must be obtained directly from Microsoft.  You can obtain the 
patch for Visio 2002 (10.0.6002) by following the instructions in the Microsoft Knowledge Base 
article 890668 available at http://support.microsoft.com/?id=890668.  Note that you must apply 
Visio 2002 Service Pack 2 before installing this patch.  Due to the severity of this problem and 
the potential for data loss, ProMax will issue a warning each time you start the application if this 
patch is not installed.  There should be no cost involved with obtaining the patch.  Please contact 
our customer support if you have questions or problems with the above requirement. 
 
Warnings and Warranty   
 
The user assumes full responsibility for the results and application obtained from the use of 
ProMax.  No implied warranty of merchantability, no implied warranty of fitness for any 
purpose, and no implied warranty arising by usage of trade, course of dealing, or course of 
performance is given by BR&E or shall arise from ProMax. 
 
THE FOREGOING WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
 
ProMax is protected by copyright law and international treaties.  Unauthorized reproduction, 
distribution, reverse engineering, or use of this program, or any portion of it, may result in severe 
civil and criminal penalties and will be prosecuted to the maximum extent possible under law. 
 
ProMax, PROSIM, and TSWEET are registered trademarks of Bryan Research & Engineering, 
Inc. 
 
Installation of ProMax 3.x 
 
ProMax uses Windows Installer Service 3.1 (WIS) technology for installation.  The installer 
supports standard as well as administrative installs through a file or application server.  In this 
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release, a security device is not required to perform the installation.  However, you must have a 
valid BR&E security device present to run ProMax.  To install ProMax on a workstation, you 
must either be an administrator, or you must have elevated installation privileges set through 
either an IntelliMirror® approach or a group policy setting.  Although not absolutely required, 
BR&E recommends that Microsoft Visio be installed and functioning prior to installing ProMax. 
 
During the installation process, ProMax 3.x will uninstall prior versions of ProMax 2.0 or 
ProMax 1.x that may be installed.  Simultaneous installation of multiple versions of ProMax is 
not allowed.  Earlier 3.x versions of ProMax will not be uninstalled, but rather upgraded to the 
new release.  User customizations made to the Options.xml file will be migrated into the ProMax 
3.x files. 
 
You should insure your system meets the minimum software requirements before installing.  
ProMax will not run properly on systems that do not meet the minimum software 
requirements.   Please see the table given earlier that provides the minimum software 
requirements.  BR&E recommends that you keep your system up to date with current service 
packs and major patches to ensure compatibility now and in the future. 
 
When performing the install, you should select to install the security device driver.  In previous 
versions, the security device driver was required only if a key was physically attached to the 
system running ProMax.  In ProMax 3.x, the driver is required to provide communication with 
the key in network licensed environments as well.  It is recommended that the installation be 
performed without the security device attached to the system. 
  
If you are using a NetHASP security device, both the NetHASP License Manager (LM) and 
HASP SRM runtime environment must be installed along with the security key on a system in 
your network for ProMax to run after installation.  You may select any system in your network 
for this service with a static IP address or hostname resolvable by DNS that is accessible by the 
workstations that will run ProMax.  The NetHASP LM software is present on the DVD in the 
“HASP & NetHASP” folder.  The LM software will also install the driver on the system.  Unless 
the NetHASP LM is accessible via broadcast, the HASP runtime environment will require 
configuration to specify the address of the system with the network key.  This configuration must 
be made on each system that will run ProMax.  In this release, the NetHASP.ini approach has 
been replaced by a web based console that configures the HASP runtime.  The web based 
application is called the HASP Admin Control Center.  The configuration is performed using 
http protocol on port 1947.  To access the configuration section, open your web browser and 
navigate to the location http://localhost:1947.  Click Configuration under Administrative Options 
followed by the Access to Remote License Managers tab.  On that page, use the Specify Search 
Parameters to enter either the IP address or the hostname of the system with the network key.  
Multiple locations may be specified by placing entries on separate lines.  This will be required if 
separate systems are used to host HASP protected applications from different vendors.  Separate 
host systems are not required with different applications as any number of keys can be attached 
to a single host.  By default, only local administration of the HASP runtime environment is 
permitted.  This can be changed on the Basic Settings tab.  For more information concerning the 
HASP Admin Control Center, select the help links on the appropriate page. 
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Performing the Initial Installation of ProMax 3.x from DVD 
This procedure is intended for use on systems that do not contain an earlier version of ProMax 
3.x, but may contain a version of ProMax 2.x or earlier.  If an earlier version of ProMax is 
installed, you should normally leave it installed so that the settings can be migrated into the 
current release during installation. 
 
To install the program on these systems, insert the DVD into your system.  The system should 
auto-run the DVD and allow you to start the installation program.  If needed, you may start the 
installation program by running the SETUP.EXE program on the DVD.  You should invoke the 
SETUP.EXE program rather than the MSI file as this program ensures all prerequisite 
components are installed.  The installation program will determine the type of installation that 
needs to be made (fresh install or upgrade) and perform the appropriate action. 
 
To perform an administrative install, you must run SETUP.EXE with the /a command line 
option.  Note that an administrative install is used for placing ProMax on a file server for 
distribution using IntelliMirror or other alternative approaches.  The administrative install does 
not actually install the application on the server.  Do not confuse an administrative install with 
the administrator account or elevated privilege requirement for installing on a single workstation.   
 
ProMax requires several prerequisite software packages to be installed before the actual ProMax 
installation can be attempted.  If you install ProMax using the SETUP.EXE program on the 
DVD, these prerequisite packages will automatically be installed if missing.  However, if you 
install ProMax on workstations in your network using the administrative installation approach or 
use another alternative installation approach, you must ensure these prerequisites are properly 
installed before attempting the ProMax installation.  Specifically, the Microsoft Core XML 
Services (MSXML) 6.0 SP1 and Microsoft SQL Server Express 2005 SP3 must be installed 
prior to installing ProMax.  SQL Server Express further requires the Microsoft .Net Framework 
2.0 SP2 be installed.  For your convenience, these prerequisites are located on the DVD 
distribution.  They are also available from the Microsoft download site, 
http://www.microsoft.com/downloads.  SQL Server Express requires special configuration for 
the ProMax installation to succeed.  In particular, a dedicated instance of SQL Express is 
required.  Please see the content of the Prerequisite.xml file for the command line required to 
install SQL Express.  SQL Server Express cannot be installed on systems with less than 512 MB 
RAM.  Under Windows 2000, SQL Server Express will fail to install if MDAC 2.8 SP1 is not 
installed.  When ProMax is removed from the system, the dedicated SQL Server Express 
instance may also be removed. 
 
If desired, Microsoft SQL Server Express 2008 may be used instead of Microsoft SQL Server 
Express 2005.  Please contact BR&E for instructions on installing Microsoft SQL Server Express 
2008. 
 
Depending on the operating system language and version, you may receive an error stating “The 
Windows Installer service cannot update the system file C:\WINDOWS\system32\msxml6r.dll 
because the file is protected by Windows. You may need to update your operating system for this 
program to work correctly.” during the installation of SQL Server Express.  This error has been 
documented by Microsoft in Knowledge Base article 958897 (see 
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http://support.microsoft.com/kb/958897).  You may click the OK button to ignore this error as 
long as no other errors occur during the installation of SQL Server Express.  ProMax is 
distributed with all available languages of SQL Server Express, and this error should not appear 
unless an English version must be installed on a non-English operating system due to the fact 
that Microsoft does not supply a version of SQL Server Express for your particular language. 
 
Updating Earlier ProMax 3.x Releases using a Windows Installer Patch 
The simplest method to upgrade ProMax is through the FLEXnet Connect service in ProMax.  
Using this approach, all of the details of downloading and applying the patch are automatically 
handled.  Simply log into an account with elevated installation privileges, and use the FLEXnet 
Connect Program Manager on the start menu in Windows (labeled Software Updates), or the 
“Help->ProMax Help->Check for Updates” menu item in ProMax itself to obtain and apply the 
patch.  You may also use the FLEXnet Connect Program Manager to download and save the 
patch, and subsequently apply it using the instructions below if it is to be applied to multiple 
systems. 
  
If desired or if you do not use the FLEXnet Connect service, you may download and apply the 
patch manually.  Please contact BR&E if you need the link for the download.  The upgrade is 
distributed as a single compressed Microsoft IExpress executable file containing the patch file 
(MSP) for the Windows Installer Service.  When warranted, BR&E provides two versions of the 
patch for download.  The binary difference patch is a smaller download, but usually requires 
access to the original ProMax DVD to apply on Windows XP and Windows 2000, but will install 
on Windows Vista and later without the media.  The full-file patch is a larger download, and 
does not require the original ProMax DVD source.  If you extract the MSP patch file from the 
download executable file, do not attempt to apply the patch by simply double clicking the MSP 
file in Windows Explorer.  You must manually run the Windows Installer program (msiexec) 
supplying the appropriate command line switches for proper patching to occur.  In general, we 
recommend you apply the patch using the downloaded executable file directly without extracting 
the MSP file as the proper command line switches are automatically inserted for you.  Improper 
command line switch usage will result in incorrect patching and application failure. 
  
For standalone installations, simply follow these instructions to install the patch (the original 
DVD distribution may be needed for the binary difference patch as discussed above): 
  
1) Log in using an account with elevated privileges. 
2) Download the patch using the FLEXnet Connect Program Manager or the link supplied by 

BR&E.  If required, supply any required information on the website. 
3) You may either download and save the patch from the website or run the self-extracting 

patch file directly without download.  If you download the patch, you must run the self-
extracting patch file after the download to start the patch process. 

  
To patch a Windows Installer administrative installation used to distribute the application in a 
network environment, the steps are: 
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1) Download the patch using the FLEXnet Connect Program Manager or the link supplied by 
BR&E.  If required, supply any required information on the website. 

2) Extract the MSP patch file to a temporary folder from the downloaded patch package. 
3) Log in using an account with sufficient privileges to modify the administrative share and to 

force redeployment of the application. 
4) Patch the administrative share using the command: 

 
msiexec /a [Path to Administrative Image]\ProMax.msi /p [Path to MSP Binary Patch] 
 

5) Force a redeployment of the ProMax application using Active Directory or other approach 
used to redeploy the application. 

 
Upgrading Earlier ProMax 3.x Releases using the DVD Distribution 
The upgrade of earlier ProMax 3.x releases may be accomplished using a ProMax DVD as an 
alternative to the Windows Installer patch.  Since the patch process is typically much faster to 
perform, the DVD will normally be distributed to customers upon request.  To upgrade a 
standalone installation, simply run the Setup.exe program on the DVD using an account with 
elevated installation privileges.  Do not uninstall the earlier release before performing the 
upgrade. 
 
If you wish to use the MSI file directly, you must issue the case-sensitive command: 
  

msiexec /i [path to DVD]\ProMax.msi REINSTALL=ALL REINSTALLMODE=vomus 
  
You cannot simply double click the MSI file in Windows Explorer because the command line 
options above will not be present.  Improper use of command line arguments will result in 
improper application installation and failure of ProMax to execute properly.  The Setup.exe 
program internally determines the current installation state and starts the msiexec process using 
the proper command line arguments. 
 
Known Issue Upgrading from the ProMax 3.0.9065 Release 
If you receive an error that contains a message with the text InstallerComponentCodeUpdate 
included, please contact BR&E for a workaround.  This issue should rarely be encountered. 
 
New Features in ProMax 3.2 Relative to ProMax 3.1 
 
1. Improvements in DGA® system predictions have been made through recommendations made 

by Huntsman Performance Products.  For the majority of cases the CO2 in the treated gas will 
be lower than in previous versions. 

2. User defined physical property packages can now be created as extensibility packages to 
ProMax.  The packages can be written as COM components or as .NET CLR classes using 
any programming language that supports these technologies. 
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3. ProMax now supports Microsoft Visio 2010 and the remaining Microsoft Office 2010 
products.  Microsoft distributes an x64 and x86 version of the Office 2010 products.  ProMax 
is only compatible with the x86 edition, even on x64 operating systems. 

4. A new TBP curve library containing almost 200 crudes has been added to the refining 
examples (file name Crude Oil Library.pmx).  The data are stored in an embedded Excel 
workbook and can be transferred to an oil defined in ProMax.  The workbook can be 
extended to include user defined oils. 

5. New tray properties are calculated including jet flood, downcomer flood, and pressure drop 
for both single and multipass trays.  Sieve and round valve trays can now also be specified. 

6. The Ionic Info Analysis has been added and calculates compositions of ionic species and the 
resulting neutral salt species in an aqueous liquid stream.  Other properties include Ionic 
strength, Osmotic Coefficient, p[H] based on concentration, and p[H] based on activity.  
Consequently, moniker and other associated capabilities are now available for these 
properties. 

7. More options have been added to the Combustion Analysis.  The user can select which 
components to exclude from the analysis.  In addition, the stoichiometric oxygen to element 
(CHSN) ratio can be changed for calculation of the required combustion oxygen. 

8. The following heat transfer fluids have been added to the program: 
 Duratherm 450, 600, 630, G, HF, HTO, LT, S, XLT50, XLT120 
 Paratherm CR®, GLTTM, HE®, HRTM, LRTM, MGTM, MR®, NF® 
 Therminol® 62, VLT, VP-3 
 Chemtherm® 700 
 Chevron:  22, 46 
 UCONTM 500 
 Mobiltherm® 43, 603 
 Coastal HITEC 
 Novo-Ufimsky Oil Refinery, JSC (Novoil) AMT-300 

9. The Line Sizing analysis now predicts Erosional Velocity using either the API RP 14E 
recommended practice or the alternative method proposed by M. Salama.  The Line Sizing 
dialogs have been redesigned for ease of use. 

10. The ability to summarize user input data has been added to standard ProMax reports. 
11. Two new “wizard” dialogs have been added to the Scenario tool to make it even easier to 

setup new tests. 
12. The phase equilibrium prediction of MTBE containing systems has been improved. 
13. Materials of construction for separator sizing and exchanger rating have been updated to the 

2010 ASME Boiler and Pressure Vessel Code. 
 
New Features in ProMax 3.1 Relative to ProMax 3.0 
 
1. The Shell Sulfinol process for acid gas treating can be modeled by those companies that have 

the proper license from Shell.  To model Shell Sulfinol, the proper amine mixture must be 
specified using a component name of “Shell Sulfolane”.  The use of “Shell Sulfolane” 
triggers the use of the properties provided by Shell.  Using the generic name “Sulfolane” will 
not provide the desired properties. 
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2. Improved the volatility of piperazine in aqueous solutions.  Improved the heat of absorption 
of CO2 in to aqueous MDEA-piperazine solutions.  

3. Added thiosulfuric acid as a dissociating compound with the following reactions: 
 

H2S2O3 ↔ H+ ൅ HS2O3
ି ↔ 2H++ S2O3

ିି 
 

4. Improved organic sulfur-water systems of DMS-H2O, DES-H2O, DMDS-H2O and CS2-H2O. 
5. Improved predictions of CO2 and NH3 in higher concentration CO2-NH3-H2O systems in the 

presence of urea. 
6. Improved O2 solubility in aqueous amine solutions. 
7. Improved HCl-H2O vapor-liquid equilibrium predictions. 
8. Enhanced salt stencil with thiosulfate salts. 
9. A new property has been added to saturators which employ a pure component as the 

saturant.  In previous versions, only the fraction of saturation could be specified.  This update 
allows the mass per standard volume (e.g., lb/MMSCF or g/scm) of the saturant in the outlet 
stream to be additionally specified. 

10. The units for Reid Vapor Pressure (RVP) no longer include the gauge or absolute designator.  
This is compatible with the reporting of RVP in ASTM D323 along with other publications 
and government regulations.  The change is intended to minimize confusion with the gauge 
pressure indicator added in ProMax 3.0.  While the gauge indicator may no longer be present, 
the pressure of the apparatus is actually a gauge pressure read from a standard pressure gauge 
of specified accuracy.  No addition of atmospheric pressure is made to the reported reading.  
Consequently, the magnitude of the value will not change.  There are two primary causes of 
the confusion with RVP units.  First, the value is typically reported without the gauge or 
absolute designation and incorrectly assumed to be an absolute pressure because most vapor 
pressures are reported in absolute pressure.  However, unlike other vapor pressure 
measurements, the RVP is measured in the presence of approximately one atmosphere partial 
pressure of air resulting in a gauge pressure that is frequently approximately the same in 
magnitude as the True Vapor Pressure (TVP) reported in absolute pressure.  Second, Note 1 
of the ASTM D323 standard states that the RVP is an “absolute” pressure.  Unfortunately, 
this is a poor choice of wording as it does not mean absolute in the sense of absolute versus 
gauge pressure.  Rather, the term means the RVP represents a total pressure. 

11. True Vapor Pressures are now expressed in gauge pressure units by default for compliance 
with various standards including ASTM D1267 and GPA 2140. 

12. Adjustments in DEPG (Coastal AGR) system prediction have been made in addition to those 
previously made in the 3.0 release.  Some of the corrections made in the 3.0 release may have 
overcorrected the results for some applications. 

13. The properties of pure argon have been improved. 
14. The densities of aqueous glycol solutions have been improved. 
15. Heat transfer curve reports for multi-sided heat exchangers now contain a table of heat 

released or acquired by each exchanger side versus temperature. 
16. New multi-sided exchanger shape (“Heat Balancer”) allows for connection of multiple 

single-sided exchangers and separators to form a single unit for reporting and rating. 
17. Several new property stencil shapes were added including: 

a. Pressure/enthalpy isotherm graphing example 
b. Simple vessel depressurizing calculator 
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c. Inline flow multiplier shape 
d. A shape to transfer heat exchanger internal data to HTRI 

18. Enhancements to User Defined reports including: 
a. Project wide scope facilitating title pages and other single output items 
b. Improved script handling in pre-process commands 
c. Ability to define component aliases and groups during reporting 

19. Scenario tool can now manipulate column Murphree efficiencies and also hide Visio to 
reduce desktop clutter. 

20. Units Set (e.g., SI, US English, etc.) can be selected directly from the menu or toolbar. 
21. The phase envelope analysis will now generate a phase envelope without any user input as 

the most commonly used parameters are now included as defaults. 
22. Improved the robustness of the NSERC2002 empirical correlations for H2, CO, and CS2 with 

respect to reactor convergence. 
23. When calculating trayed column flood for low liquid rate service such as glycol contactors, 

ProMax will no longer issue warnings due to low liquid rate unless the flow parameter is 
below 0.0001. 

24. The minimum thickness for shells and heads is now set to 1.5 mm in accordance with ASME 
pressure vessel code part UG-16. 

25. For Separator Sizing and Exchanger Rating, Materials of Construction and formulas for wall 
thickness or maximum allowable working pressure have been updated to the 2009b Addenda 
of the 2007 ASME Boiler and Pressure Vessel Code. 

26. For Pipelines and Line Sizing, Thermoplastic Materials of Construction have been updated to 
The Plastics Pipe Institute TR-4/2009. 

27. For Pipelines and Line Sizing, the OLGAS third-party correlation for multiphase flow has 
been updated to OLGAS 5.3.2.1.  OLGAS is available in ProMax by purchasing a separate 
license from SPT Group. 

28. The Recycle block now has a “Copy from Inlet” feature to aid in setting an initial guess for 
the Recycle outlet stream.  The user can solve the simulation as an open loop, copy the 
Recycle inlet stream to the outlet as an initial guess, close the loop, and then allow the 
Recycle to converge the loop. 

29. Import/Export locations to Excel cells can be moved without the need of deleting and adding. 
30. Addition of an ActiveX control that allows display of property tables in other applications 

(e.g., Word, Excel, and Visio).  This feature can be used to display property tables from 
different flowsheets together.  Property tables can also be combined into a single table. 

31. In Property Tables and Callouts, significant figures can be set for each property individually. 
32. Callout properties can be displayed in vertical as well as horizontal orientation. 
33. Ability to copy/paste from clip board the contents of a Property Table or Callout to other 

applications such as Excel, Word, etc.  Additionally the contents may be pasted directly into 
the ProMax Visio based flowsheet.  Text format carries the full precision on properties.  
Metafile format (picture) is a snap shot of the control, but can be rotated to any angle if 
needed.  RTF and HTML format can be used for displaying as text but with original 
precision and symbols. 

34. Thermal efficiencies can now be used in absorbers with side feeds. 
35. Improvements have been made for use of propylene glycol as a heat transfer fluid. 
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36. The nucleate boiling film correlation can now be selected between the correlations of 
Mostinski (1963) and Cooper (1984).  The Mostinski correlation, which is frequently too 
conservative, was the only correlation present in previous versions of ProMax. 

37. ProMax will utilize some of the capabilities present in the new task bar design of Microsoft 
Windows 7. 

38. For VBA and automation users, more than one instance of ProMax can be created in one 
application to do side projects. 

 
New Features in ProMax 3.0 Relative to ProMax 2.0 
 
1. The electrolytic models have been extended to characterize more completely the short range 

ionic interactions that occur in solution.  These modifications include the amine-acid gas 
system and the ammonia-acid gas systems.  The changes improve the model predictions for 
the acid gas vapor-liquid equilibria, and enable better predictions for more concentrated 
solutions and higher acid gas loadings.  For the MDEA-CO2-H2O system in particular, this 
has resulted in more optimistic predictions relative to ProMax 2.0 version. 

2. The electrolytic models include the dissociation for the following molecular components:  
Sulfur Dioxide, Phenol, Calcium Hydroxide, and Piperazine. 

3. Several improvements have been made with regard to glycol dehydration and glycol injection 
processes. 
a. In ProMax 2.0, changes were made based on customer comments that caused the 

performance of TEG units to be more conservative with respect to water content relative 
to ProMax 1.2. After release of ProMax 2.0, BR&E decided to scrutinize this problem 
fully and decided that there were simply insufficient reliable data in critical areas of this 
process.  In some regions, the only data present are graphs that disagree from vendor to 
vendor, and frequently from publication to publication from the same vendor.  Most 
importantly, these graphs do not provide an indication of how much measured data are 
used to create them and if true measurements are present in the critical regions.  The 
nature of these data leads to significant design uncertainties, especially for high dew point 
depression systems.  Consequently, BR&E commissioned a study with a reputable 
research firm with significant experience collecting this type of data to acquire VLE data 
in these questionable areas.  Further, the group was asked to collect data in regions that 
we felt were known with some confidence to insure the quality of the measurements.  The 
results of this experimental study have been incorporated into ProMax 3.x.  Therefore, 
the user will find that ProMax 3.x will not be as conservative as previous releases of our 
software and the user should not assume conservative results are generated using ProMax 
3.x. 

b. Improvements in prediction of solubilities of minor components in glycol systems have 
been made.  These include hydrocarbons and various sulfur species.  While only small 
amounts of data are present for many of these minor components, the results from 
ProMax 3.x should be more reliable than earlier versions. 

4. For most systems, ProMax 3.x should require less calculation time than its earlier versions. 
5. RVP units have been changed to gauge from absolute pressure.  This will require all 

calculators that use RVP to be adjusted for the new units.  Other uses in the program are 
automatically fixed when the file is read. 
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6. Projects can now be exported for appending in other projects.  A project is exported in its 
entirety into a file with a pmxexp extension.  This file can then be appended to other projects 
using the File menu.  Objects with conflicting names are automatically renamed during the 
append process.  Among other uses, this procedure can be used to create templates of 
common processes (e.g., dehydration, amine sweetening, refrigeration, etc.) for appending in 
other projects.  Since the process of exporting and appending transfers the project in its 
entirety, the project upon which the export is based should normally be as simple as possible 
to prevent deleting unused objects after the append.  Please note that you should keep both 
the standard project file (pmx) along with the export file (pmxexp).  The export file is 
specific to the version of Visio used to create it and will need to be recreated from the pmx 
file when a Visio upgrade is made. 

7. Improvements in predictions for DEPG (Coastal AGR) systems have been made.  Among the 
many improvements include better prediction of high hydrogen systems such as those 
involved in synthesis gas treating.  Improvements in hydrocarbon solubility predictions have 
also been made. 

8. The ability to model gas treating (including synthesis gas) using the physical solvent 
propylene carbonate has been added.  The recommended property package for this system is 
either Peng-Robinson or SRK. 

9. Extractive processes for olefins and acetylenes utilizing N,N-Dimethylformamide (DMF) can 
now be modeled.  The appropriate property packages include either the Gibbs excess models 
(e.g., NRTL) or Peng-Robinson Polar or SRK Polar. 

10. Pertinent information from GPA Standard 2145-09 has been added to ProMax due to its 
recent adoption. 

11. The correlations in Figure 22-10 of the 12th edition GPSA Engineering Databook for COS 
and CS2 hydrolysis have been added.  These correlations can be added to any Claus bed to 
model the hydrolysis of COS and CS2 into H2S and CO2.  The correlations are for activated 
alumina catalysts.  Other catalysts will yield different performance.  In addition, a new Gibbs 
set named “GPSA Hydrolyzing Claus Bed” has been created that will automatically add 
these correlations to a Gibbs minimization reactor.  The previous “Hydrolyzing Claus Bed” 
has been renamed to “Equilibrium Hydrolyzing Claus Bed” to indicate that the hydrolysis is 
modeled at equilibrium.  While normally predicting a conversion less than equilibrium 
conversion, the GPSA hydrolysis correlations can predict a conversion that exceeds 
equilibrium conversion at certain conditions.  This fact is a general statement for any 
conversion correlation.  When this occurs, a warning is provided in the reactor.  One remedy 
for this warning is to deactivate the constraint of the offending component (usually COS) so 
that it is modeled at equilibrium.  The component must remain active in the reactant list or it 
will be considered an inert.  Alternatively, a linear constraint may be constructed to limit the 
conversion. 

12. The following changes have been made to the heat exchanger rating program: 
a. Double pipe heat exchangers can now rate Inline (straight path) as well as Hairpin (U-

tube) type exchangers. 
b. Heat transfer film coefficients have been improved, especially for boiling and 

condensation conditions.  Calculation of condensation film coefficients has been made 
less aggressive when non-condensables are present. 

c. Several issues affecting calculations of tube count and total area have been resolved. 
d. Several issues in heat exchanger pressure drop calculations have been resolved. 



 

BR&E ProMax 3.2.10286.0 Release Notes Copyright © 2002-2010 BRE Group, Ltd. 
 

13

e. Impingement calculations and recommendations for shell and tube exchangers have been 
improved. 

f. The ProMax double pipe shell side interface has been simplified to remove unnecessary 
properties. 

g. Several new properties have been added and are described in the ProMax Help. Specific 
properties at each side increment are grouped on a Detail tab apart from the more general 
properties. 

13. The cross exchanger properties Minimum End Approach Temperature, Log Mean 
Temperature Difference and End Point UA can now be set by the user. A direct solution will 
only be obtainable for those cases in which at least two of the connected streams can be 
solved independently before the cross exchanger is called upon to solve for the remaining 
streams.  Other cases will require a recycle with initial guess for calculation. 

14. Tooltips that display values in common units are shown when the mouse is placed over a 
value.  These tooltips can be disabled by the user if desired.  Further, the units which are 
displayed for a value can be configured by modification of the Options.xml file. 

15. Reporting flexibility has been greatly increased with the user capability to define templates 
for Microsoft® Excel reporting.  These templates are standard Excel workbooks that are 
edited with a report editor supplied in the Excel Add-In “ProMax User Defined Report.xla” 
located in “%ProgramFiles%\Bryan Research & Engineering\ProMax3\AddOns\Excel” 
folder.  The editor gives the ability to place ProMax data in locations while leaving other 
aspects of formatting and layout to the familiar tools built into Excel.  Report templates can 
be applied to any ProMax project via ProMax’s Report dialog.  For further information or 
assistance with template creation, please contact our technical support group at 
support@bre.com. 

16. A custom property package is no longer required to obtain liquid densities from the equation 
of state.  When applicable, the density selection in the environment will allow the EOS 
density to be selected in addition to either COSTALD or Rackett.  EOS densities normally 
provide better estimates for the liquid in the critical region.  The application of EOS densities 
will most commonly be encountered in CO2 acid gas injection systems. 

17. The Span and Wagner equation of state for pure CO2 was implemented based on Span, R., 
Wagner, W., J. Phys. Chem. Ref. Data, Vol. 25, No. 6, 1996, pp. 1509-1596.  This equation 
of state represents most experimental data within experimental uncertainties. It produces 
exceptional accuracy in the critical region. In addition, in technically important regions up to 
pressures of 30MPa and up to temperatures of 523K, the estimated uncertainty of the 
formulation ranges from ±0.03% to ±0.05% in density and ±0.15% to ±1.5% in the isobaric 
heat capacity. This empirical formulation is valid in the fluid region up to temperatures of 
1100K and at pressures up to 800 MPa.  This model can be used to model acid gas injection 
systems without water present to determine if the properties computed by other EOS's such 
as Peng-Robinson or SRK are accurate enough for use.  Since this equation of state is a pure 
fluid equation of state, no hydrate predictions can be made with this package. 

18. The IAPWS (International Association for the Properties of Water and Steam) Formulation 
2001 for Thermodynamic Properties of Ammonia-Water mixtures presented in Guideline on 
the IAPWS Formulation 2001 for the Thermodynamic Properties of Ammonia-Water 
Mixtures, The International Association for the Properties of Water and Steam, Gaithersburg, 
Maryland, 2001, has been added as the Tillner-Roth and Friend NH3 + H2O Property 
Package.  This correlation provides the most accurate description of thermodynamic 
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properties of ammonia-water mixtures available at the time it was developed over a wide 
range of conditions.  It is valid in the vapor and liquid phases for pressures up to 40 MPa.  
The formulation represents the vapor-liquid equilibrium properties with an uncertainty of 
±0.01 in liquid and vapor mole fractions.  In the single phase region, uncertainties are 
estimated from ±0.3% to ±1% in vapor density and from ±0.3% to ±2% in liquid density, and 
±200 J/mol for enthalpies.  This model can be used to represent ammonia-water mixtures as 
the working fluid in absorption refrigeration cycles or other systems where binary ammonia-
water mixtures are encountered.  Additionally, the equation of state for pure ammonia 
presented by Tillner-Roth, R., Harms-Watzenberg, F., Baehr, H.D., Eine neue 
Fundamentalgleichung für Ammoniak, Proc. 20th DKV-Tagung Heidelberg, Germany, Vol. 
II, 1993,  pp. 167-181, has been added.  The ammonia correlation provides a good 
description of the thermodynamic properties of ammonia over a wide range of measurements 
available at the time this correlation was formulated.  Finally, the IAPWS Formulation 1995 
for Thermodynamic Properties of Water implemented by Wagner, W., Pruss, A., J. Phys. 
Chem. Ref. Data, Vol. 31, No. 2, 2002, was added.  This formulation covers a range of 
temperatures from the melting line (lowest temperature 251.2K at 209.9 MPa) to 1273K and 
pressures up to 1000 MPa.  In the liquid region, the estimated uncertainty ranges from 
±0.001% to ±0.02% in density and ±0.1% in the isobaric heat capacity.  In the gas region, the 
estimated uncertainty ranges from ±0.03% to ±0.05% and ±0.2% in the isobaric heat 
capacity.  In the critical region, the IAPWS-95 formulation represents with a very good 
accuracy both thermal and caloric properties. 

19. The individual diatomic deuterium (D2) modifications are now present in ProMax.  The 
program includes orthodeuterium, paradeuterium, equilibrium deuterium, and normal 
deuterium.  The previous versions of the program only included normal deuterium.  Normal 
deuterium is a constant composition mixture of 75% paradeuterium and 25% orthodeuterium.  
ProMax will accurately predict the equilibrium distribution of para and ortho deuterium in a 
Gibbs free energy minimization reactor.  If the generic names for diatomic deuterium (i.e., 
D2, Deuterium) are selected as components, the program will use normal deuterium as in the 
past. 

20. Materials of Construction for pressure vessels and exchanger rating have been updated to the 
2007 ASME Boiler and Pressure Vessel Code, including the 2008a Addenda. 

21. Thermoplastic piping is now available as a Material of Construction in the Pipeline block and 
Line Sizing analysis. 

22. In the Line Sizing analysis, two additional pressure design codes are available for calculating 
the Maximum Allowable Working Pressure: 
 Canadian Standards Association CSA Z662 Oil and Gas Pipeline Systems  
 ASME B31.4 Pipeline Transportation Systems for Liquid Hydrocarbons and Other 

Liquids. 
23. The materials in CSA Z245.1 "Steel Pipe" are available as Materials of Construction for Line 

Sizing and Pipelines. 
24. In the Line Sizing analysis, the B31.3 pressure code has been updated to include the Weld 

Joint Strength Reduction Factor, which was added to the design equation by errata in ASME 
B31.3-2006.  The coefficient Y has also been added.  Both of these parameters are calculated 
by ProMax or can be optionally specified by the user. 

25. Standard Dimension Ratio (SDR) pipe sizes and all pipe sizes from ASME B36.10M are now 
available in the Line Sizing analysis and the Pipeline.  Pipe sizes can be specified in either 
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Nominal Pipe Size (NPS) or Diameter Nominal (DN), which is the dimensionless designator 
used in the metric system to describe pipe size.  The NPS, DN, and thickness can be selected 
from dropdown lists of the sizes available for the specified Pipe Schedule. 

26. Absolute Roughness values for common pipe materials can be selected from dropdown lists 
in Pipelines and Line Sizing analyses. 

27. Pipeline enhancements include: 
 The Initial Value Method, either EPISODE or Runge-Kutta, can now be selected when 

the Continuous Solution Method is specified.  EPISODE is the default, but Runge-Kutta 
may solve faster in some cases. 

 An option to Check Freezeout per Increment has been added.  By default, it is unchecked, 
and Freeze Out will be checked only at the beginning and end of the pipeline and 
between segments or fittings.  If this property is check-marked, then Freeze Out will be 
checked at every increment to determine exactly where freeze out begins or is within 
range of freezing. 

 For pipelines with multiple pipe segments, if only one Ambient Temperature is specified, 
all other segments will default to this Ambient Temperature.  For wells with specified 
elevation changes in the segments, if at least two Ambient Temperatures are specified, 
the other Ambient Temperatures will be calculated based on the elevation gradient of the 
specified temperatures. 

 Pressure drop through valves and fittings can now be calculated using the Equivalent 
Length ratio, L/D, which may be more accurate than the Fitting Kv calculation for 
compressible flow, especially near sonic velocity. 

28. Distillation Column Hardware properties can now be specified directly in the Hardware 
dialogs.  The Edit dialogs have been removed. 

29. ProMax can now be used to size liquid-liquid columns by using the liquid load (total liquid 
flux) on a stage.  Specify either the diameter or the liquid load (which is sum of both liquid 
flows on stage) and the other parameter is calculated. For amine liquid-liquid columns, 
recommended liquid loads are 15 gpm/ft2 (610 lpm/m2) for gas plants and 10 gpm/ft2 
(405 lpm/m2) for refinery service. 

30. Distillation columns now allow Murphree Efficiencies greater than 100%, which can be 
useful to fine tune predictions to operating data for amine and other columns. 

31. The dialogs for the Recycle/Propagation Terminal have been redesigned for ease of use. 
32. The advanced solver and specifier provide additional flexibility in the calculation source.  

Previously only Excel and VBScript or JScript were allowed.  In the current version, the 
option of using Visual Basic for Applications (VBA) in Visio or Excel and the use of an 
external COM object written in any COM compliant programming language are available.  
ProMax can directly call the COM object, or you can connect your implementation to 
ProMax using COM connection points (events).  The connection point method is also 
available in VBA.  These new capabilities make it easier to create solvers and specifiers 
based on programs that may already be internally available. 

33. The combustion analysis will now calculate heating values on a molar, mass, and volumetric 
basis.  In addition, the combustion and metering temperatures may be specified at the 
combustion analysis level to serve as the basis for computation.  For more information, see 
GPA Standard 2172 and ISO 6976. 
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34. ProMax Property Stencil has been expanded with several new calculation shapes, a simple 
membrane and orifice plate block.  Two selection shapes were also included to assist users in 
creating their own block shapes, and to add default values and calculators to block shapes. 

35. The Bottoms Head specification has been added to the staged column properties to account 
for the liquid head between the bottom of the column and the reboiler. 

36. Sizing a three phase separator no longer requires a vapor flow. 
37. Petro-Therm™ and Shell Thermia® C heat transfer fluids have been added. 
38. The units TR for ton of refrigeration and RT for refrigeration ton have been added. 
39. Adjustments and bug fixes have been made to curve oils. If the user wishes to incorporate 

these changes into existing flowsheets the oil must be recharacterized manually by the user. 
This can be done by modifying something in the characterization.  
 The easiest way to recharacterize the boiling point data is by changing the Assay Type 

and then resetting to the original Assay Type.  
 The easiest way to recharacterize user supplied curve data for specific gravity and 

molecular weight is to edit the data, alter the amount for the highest or lowest fraction 
distilled, click OK, and then reedit the data restoring the original value. 

 The easiest way to recharacterize user supplied curve data for high and low temperature 
viscosity is to delete the Viscosity Assay temperature and hit enter to restore the 
temperature.  

40. Most examples have been updated and several new examples have been added to 
demonstrate new or improved features of the program. 
 An MDEA Sweetening with Piperazine example has been added to the Amine 

Sweetening folder. 
 A pair of examples has been added to the Calculators folder to demonstrate new 

calculator Source Types, a VBA type and an Event Based type (using VBA). 
 The Gas Processing folder contains new JT examples, a GSP unit, and a propylene 

carbonate unit for synthesis gas treatment.   
 The Refining folder contains many new examples: Benzene Removal from Fuel Stock, 

Butadiene Extraction using DMF, Hydrogen Production and Purification, a new Coker 
Fractionation column with side strippers, an FCC Fractionation column, and an FCC SO2 
Offgas Scrubber. 

 Most Sulfur Recovery examples have been converted to employ the GPSA Hydrolyzing 
Claus Bed Gibbs Set. 

 A new Power and Refrigeration folder demonstrates the setup of ammonia absorption 
refrigeration, Kalina and Rankine cycles, and refrigerant systems.   

The examples have been solved in ProMax 3.x and each example is ready for inspection 
41. Several bug fixes have been made. 
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Support and Contact Information 
 
Bryan Research & Engineering, Inc. 
3131 Briarcrest Dr. 
Ste. 200 
Bryan, TX   77802   USA 
979-776-5220 
support@bre.com 
http://www.bre.com 


